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Menus

The File menu
The Text menu
The Display menu
The Help menu



The Toolbar

The Toolbar provides a quick method of accessing many of Font Printer's features.

      Print selected fonts       Print Default text

      Printer setup       Print Custom text

      Bold       Keyboard display

      Italic       Extended character grid display

      Underline       Text box display

      Print Extended characters

      Print the ANSI character set

      Print the OEM character set



Getting Started

Screen fonts vs. Printer fonts

Selecting fonts
Printing fonts
Displaying fonts



      What is Font Printer?

Font Printer is a program for Microsoft Windows that allows you to easily print all available characters in 
one or more selected fonts.    In addition to printing font samples, you can view samples of screen fonts in 
a variety of ways.    This program is especially useful if you have a large number of    fonts installed on 
your system.    Font Printer has been tested with ATM and True Type fonts but there is no reason other 
font packages shouldn't work.

Font Printer makes it very easy to print a sample of all characters in the specified font(s), including the 
normal characters accessed by pressing keys on the keyboard, as well as the extended ASCII characters 
in both the ANSI and OEM character sets.

Font Printer was designed to be flexible and easy to use without sacrificing power.      The premise is 
simple --    allow the user to select any combination of    fonts and print a nicely formatted sample of each. 
The selected fonts can be printed in bold, italics and underline or any combination of attributes. 



What's new in version 2.0

There are over twenty new features in this version of Font Printer.    Below is a list of some of the more 
notable additions and changes:

- Completely redesigned user interface.

- A toolbar has been added, allowing quick access to many features.

- Many aspects of Font Printer are user customizable.

- You can now display and print the ANSI as well as the OEM character sets.

- Two new font viewing screens have been added    -- a keyboard display and an extended ASCII 
character grid.    The Text box display has also been enhanced.

- Characters can be copied and pasted into other applications from any of the displays.

- Display and printing performance has been improved.

- Full on-line help has been added.

- Selecting and setting up printers is now an integral part of Font Printer .    There is no need to 
start    up the Control panel to configure printers.

- Text is displayed as you select fonts.    This text is user customizable.

- Support is now offered to registered users.



Registering Font Printer

License Agreement 
 
INSTALLATION OF FONT PRINTER ON YOUR COMPUTER SYSTEM IMPLIES AGREEMENT WITH 
THE TERMS AND CONDITIONS BELOW. 
 
Font Printer is distributed as Shareware.    It is not free, freeware, or in the public domain.    You may use 
Font Printer for a trial period of thirty days, at no cost to you, to determine if it meets your needs. If you 
decide to use Font Printer regularly, you are expected to register it and pay the applicable registration fee. 
Individual copies of the unregistered version of Font Printer may be given to your friends and associates 
for the same thirty-day free trial period.    You may also upload Font Printer to the public section of a public 
BBS.
 
You may not modify or disassemble Font Printer,    nor distribute any modified or disassembled versions of 
Font Printer.    Font Printer may not be included with any other product without written permission from 
Mark Towslee.
 
If this program is used for more than thirty days, you are required to register it and send $15.00 to the 
following address. 

Mark Towslee 
P.O. Box 554
Niverville, NY 12130

I can also be reached through Prodigy id MHKH81A, through America On-line id MTOWSLEE or via the 
Internet at Mtowslee@aol.com. 



The File menu

Font Printer allows you to save lists of fonts so that you can quickly and easily print samples of oftenused 
fonts.    Font lists are saved in ASCII files with an extension of .FPL.

File/New
File/Open
File/Save
File/Save As ...
File/Print
File/Printer Setup
File/Preferences
File/Exit



File/New

The File/New menu option allows you to clear the current selections and start a new list of saved fonts.

To open a new file:

1. Choose File/New.

2. If you have already selected fonts you will be prompted to save the currently selected fonts.

3. Start choosing fonts.



File/Open

The File/Open menu option allows you to load a saved font list.

To open a saved font list:

1. Choose File/Open.

2. Select the file to load from the list box.

3. Press the OK button.



File/Save

The File/Save menu option allows you to save the currently selected fonts to a file for later use.    Saved 
font lists are saved with an extension of .FPL.

To save the currently selected fonts to a file:

1. Choose File/Save.

2. If the file is untitled, you will be prompted for a file name,; otherwise, the current file name is used.



File/Save As ...

The File/Save As ... menu option allows you to save the currently selected fonts to a new file.    Saved font 
lists are saved with an extension of .FPL.

To save a file with a new name:

1. Choose File/Save As ...

2. Enter a file name.

3. Press the OK button.



      Printing selected fonts

The are three ways to print the selected fonts.    In all cases, printing progress is displayed, as well as the 
font name currently being printed and, if applicable, the character set being printed.

Printing from the menus:

1. Choose File/Print.

2. Press the Cancel button to cancel printing.

Printing from the Toolbar:

1. Click on the  button on the Toolbar.

2. Press the Cancel button to cancel printing.

Using the Print button:

1. Click on the button between the two list boxes marked Print.

2. Press the Cancel button to cancel printing.



      Printer Setup

The Printer Setup option allows you to choose and configure any printer installed on your system.

Choosing a different printer from the menus:

1. Choose File/Printer Setup.

2. Select a printer and any options in the dialog box provided.

3. Press the OK button to save your changes and return. (to what?)

Choosing a different printer from the Toolbar:

1. Click on the  button on the Toolbar.

2. Select a printer and any options in the dialog box provided.
3. Press the OK button to save your changes and return.



Preferences 

The File/Preferences menu option allows you to customize Font Printer by setting various options. 

The following items can be changed from this dialog box:

- Title font

- Left printer margin

- External font utility name

- Whether Font Printer should indicate when new fonts are installed or not

- Whether samples should be displayed as you select fonts or not

- Change the color used for Font Printer screens



File/Exit

The File/Exit menu option closes Font Printer.



Changing the Title Font

The Title font is the font used to print the title on sample printouts.    The title is the descriptive text that 
appears above each font sample. 

This is the title ===> Arial 12 Point   

ABCDEFGHIJKLMNOPQRSTUVWXYZ

abcdefghijklmnopqrstuvwxyz

1234567890-=[];',./\`

!@#$%^&*()_+{}:"<>?|~

To change the font used to print the titles:

1. Choose File/Preferences.

2. Choose a font name from the drop-down list box titled "Font to use for Titles."

3. Press the OK button to save your changes or the Cancel button to lose your changes.



Changing the Left Margin

The Left Margin setting allows you to specify where you would like to start printing.    The default is 1" 
which works well for adding samples to a binder.

To change the Left Margin setting:

1. Choose File/Preferences.

2. Type in a value in inches indicating where you would like to set the left margin for your printer.

3. Press the OK button to save your changes or the Cancel button to lose your changes.



External Font Utility

Font Printer allows you to choose another utility that can be started directly from within Font Printer.    This 
allows you to start the CharMap utility, the ATM control panel, or any other utility by specifying the file 
name in the File/Preferences dialog box.

To change the External font utility:

1. Choose File/Preferences.

2. Type in a full path and file name for the file that should be run when the user selects 
Display/External font utility.

3. Press the OK button to save your changes or the Cancel button to lose your changes.



Indicating when new fonts are found

By default, Font Printer will prompt you whenever it finds fonts that were not present the last time you 
used it. This feature can be disabled to save loading and exiting time.

To change whether of not Font Printer prompts you when it finds new fonts:

1. Choose File/Preferences.

2. Click on the check box    to toggle this feature on and off.

3. Press the OK button to save your changes or the Cancel button to lose your changes.



Displaying samples as they are selected

By default, Font Printer displays font samples as they are selected.    The samples are displayed directly 
below the two main list boxes and can be toggled on and off. 

To toggle this feature on and off:

1. Choose File/Preferences.

2. Click on the "Display fonts as they are selected" check box.

3. Click on the OK button to save your changes or the Cancel button to lose your changes.

See also: Changing the sample text



Changing the sample text

Font Printer will display a short sample of text in the selected font below each of the list boxes.    This 
feature can be toggled on and off via the File/Preferences menu option.    You can also specify your own 
text (up to 20 characters) that will be displayed.

To change the sample text using the menus:

1. Choose Text/Change sample text.

2. Enter up to 20 characters in the space provided.

3. Click on the OK button to save your changes or the Cancel button to lose your changes.

To change the sample text using the mouse:

1. Double-click on one of the sample text boxes under the main list boxes.

2. Enter up to 20 characters in the space provided.

3. Press the OK button to save your changes or the Cancel button to lose your changes.

To revert to the Default sample text:

1. Choose Text/Return sample text to default

2. The sample text will change back to Aa Bb Cc Dd.

See also: Displaying samples as they are selected



Changing Colors

Font Printer allows you to specify the background color used in the various forms.    You can choose one 
of the predefined colors or you may define your own custom colors.

To change the background color for forms:

1. Choose File/Preferences.

2. Click on the Colors button.

3. Click on one of the predefined colors or press the Custom button to define your own custom color.

4. Click on OK to preview changes.

5. Press the OK button to save your changes or the Cancel button to lose your changes.



Selecting fonts

Font Printer makes choosing fonts very simple.    You can select one, some, or all fonts to be printed.

The Add and Remove buttons between the list boxes allow you to select and deselect fonts that you 
would like to print.

The refresh button refreshes the list of fonts currently available for printing.    It is possible that fonts were 
added or removed while Font Printer was inactive.    This situation can occur when you change printers 
through the Control Panel or when certain applications (such as Ami Pro) start or end and add or remove 
their own fonts.

There are two ways to select and deselect fonts for printing:

- Double-Click on the font name to move it to the other list box.

- Click on the font name and press either the Add or Remove button to move it to the other list box.

See also: Printing selected fonts



      Printing selected fonts

The are three ways to print the selected fonts.    In all cases, printing progress is displayed, as well as the 
font name currently being printed and, if applicable, the character set being printed.

Printing from the menus:

1. Choose File/Print.

2. Press the Cancel button to cancel printing.

Printing from the Toolbar:

1. Click on the  button on the Toolbar.

2. Press the Cancel button to cancel printing.

Using the Print button:

1. Click on the button between the two list boxes marked Print.

2. Press the Cancel button to cancel printing.

See also: Selecting fonts



      Bold button

When the Bold button on the toolbar is depressed, samples printed and displayed will have the Bold 
attribute set.



      Italic button

When the Italic button on the toolbar is depressed, samples printed and displayed will have the Italic 
attribute set.



      Underline button

When the Underline button on the toolbar is depressed, samples printed and displayed will have the 
Underline attribute set.



Displaying fonts

Font Printer allows you to view your fonts in a variety of ways.    The different views can be accessed via 
the menus or by pressing the appropriate button on the toolbar. 

Button Menu command

Display/Text box

Display/Keyboard

Display/Extended character grid

               Display/External font utility  



      The Text box display

The Text box display allows you to view fonts in an editable text box.    You can view any screen font 
installed on your system, as well as copy characters to the clipboard. 

Options available while viewing in the text box:

1. Select the font name and font size from the drop-down list boxes on the toolbar.

2. Depress the Bold, Italic, and Underline buttons to select their respective attributes.

3. Depress the OEM or ANSI buttons to choose the character set.

To copy the selected text to the clipboard:

1. Select the text to copy.

2. Press the  button.

3. The characters can now be pasted into other applications.



      The Keyboard display

The Keyboard display lets you view fonts as they appear on a simulated keyboard.    From this screen you 
can view characters at various levels of magnification as well as copy characters to the clipboard.

The panel below the keyboard shows you the keystrokes necessary to access the character from the 
keyboard.    This is especially useful when viewing symbol characters.

To inspect a specific character more closely, click and hold the left mouse button down.    An enlarged 
version of the character will pop up.

Choosing a font
Copying characters to the clipboard
Selecting the level of magnification



      The Extended character display

The Extended character display lets you view the Extended ASCII characters in a large grid.    From this 
screen you can view characters at various levels of magnification and copy characters to the clipboard.

The title bar indicates the currently active character set and the panel below the grid shows you the 
keystrokes necessary to access the character from the keyboard. 

To inspect a specific character more closely, click and hold the left mouse button down.    An enlarged 
version of the character will pop up.

Choosing a font
Copying characters to the clipboard
Selecting the level of magnification
Switching between the ANSI and OEM character sets

See also:
Printing Extended characters



Display/External Font utility

The External Font utility is a utility that you specify on the File/Preferences dialog box.    This can be any 
valid program name and is provided so that you can quickly start up an alternate font utility, the Control 
Panel, or whatever you decide is appropriate.

To start the External font utility:

- Choose Text/External Font Utility menu option.



Choosing a font to view

Once you have switched to the Keyboard display or the Extended ASCII character grid, you can select a 
font to use.

To select a font to view:

- Click on a font name in the list box provided.

- The screen will be updated and display the font selected.



Copying characters to the clipboard

Once you have switched to the Keyboard display or the Extended ASCII character grid, you can copy 
characters to the Windows clipboard so that they can be inserted into other Windows applications.    This 
saves you from having to look up the ASCII character value and then manually keying it into another 
application.

To copy characters to the clipboard:

1. Select the character you wish to copy by clicking on it.    The background will change to a light 
yellow to indicate that it is the currently selected character.

2. Press the Copy button.



Setting the magnification level

Changing the magnification level allows you to enlarge a font so that you can see subtle details in 
individual characters.

To change the magnification level:

- Click on the horizontal scroll bar below the Clipboard contents box to raise and lower the 
magnification level. 



Switching between the ANSI and OEM character sets

Windows normally uses the ANSI character set but Font Printer allows you to view all of the characters in 
either    the ANSI or the OEM character set. 

To toggle between the ANSI and OEM character sets:

- Click on the button labeled either "ANSI" or "OEM," depending on which character set is currently 
active.

- The screen will be updated to show the new character set.



ANSI Character set

The ANSI character set is the character set used internally by Windows. 

The definition given by Microsoft is: 

"Windows-to-OEM mappings are defined by the keyboard driver, where this function is 

implemented. Some keyboard drivers may have different mappings than others, depending on 

the machine environment, and some keyboard driver support loading different OEM character 

sets; for example, the standard U.S. keyboard driver for an IBM keyboard supports loadable 

code pages, with the default being code page 437 and the most common alternative being code 

page 850. (The Windows character set is sometimes referred to as code page 1007.) "



OEM Character set

The OEM character set is the character set used by MS-DOS applications.

The definition given by Microsoft is: 

"Windows-to-OEM mappings are defined by the keyboard driver, where this function is 

implemented. Some keyboard drivers may have different mappings than others, depending on 

the machine environment, and some keyboard driver support loading different OEM character 

sets; for example, the standard U.S. keyboard driver for an IBM keyboard supports loadable 

code pages, with the default being code page 437 and the most common alternative being code 

page 850. (The Windows character set is sometimes referred to as code page 1007.) "



      Bold button

When the Bold button on the toolbar is depressed, samples printed and displayed will have the Bold 
attribute set.



      Italic button

When the Italic button on the toolbar is depressed, samples printed and displayed will have the Italic 
attribute set.



      Underline button

When the Underline button on the toolbar is depressed, samples printed and displayed will have the 
Underline attribute set.



      Printing the Extended ASCII characters

Pressing the  button tells Font Printer that you want to include the Extended ASCII characters when 
you print your font samples.    If this button is not pressed, only the normal keyboard characters will be 
printed.

The  button tells Font Printer that you want to print the OEM character set while the 

 button indicates that you want to print the ANSI character set.    Font Printer will print sample pages 
including one or both character sets, depending on the state of the OEM and ANSI buttons.

To print font samples including the extended ASCII characters:

1. Choose the fonts that you would like printed samples of by double-clicking on the font name or by 
clicking on the font name and pressing the Add button.

2. Press the  button on the toolbar.

3. To include the OEM character set, press the  button.    To include the ANSI character, set 
press the 

 button.
4. Select the attributes (bold, italic, underline).
5. Press the Print button.

See also: Displaying Extended characters



The ASCII character set

The ASCII character set is composed of 256 characters.    Characters with ASCII values between 0 - 31 
are control characters, 32 - 127 are keyboard and punctuation characters and the Extended ASCII 
characters are the characters with an ASCII value above 127. 

Font Printer supports displaying and printing both the ANSI character set and the OEM character set.    
The characters with ASCII values below 128 are the same in both character sets; however, the extended 
characters are usually different.    By switching character sets, you get 50% more characters to choose 
from per font. 

Characters from both character sets can be typed or copied and pasted into other applications.    To 
access a character in the ANSI character set you press Alt+NNN where NNN is the ASCII character 
value.    To access the OEM characters you press Alt+0NNN where NNN is the ASCII value.    The only 
difference is that the OEM ASCII value that you key in is always preceded by a zero.



      Printing the Default text

By default, Font printer prints all of the characters available on the keyboard; but you are also able to 
define your own custom text to use when printing font samples.

The default text is:

 ABCDEFGHIJKLMNOPQRSTUVWXYZ

    abcdefghijklmnopqrstuvwxyz

    1234567890-=[];',./\`

    !@#$%^&*()_+{}:"<>?|~

To tell Font Printer to use Default text when printing font samples:

1. Depress the  button on the toolbar

See also:
Printing Custom text



      Printing the Custom text

By default, Font printer prints all of the characters available on the keyboard; but you are also able to 
define your own custom text to use when printing font samples.    The custom text can loaded from an 
ASCII file or be typed in manually. 

Several text files that can be used in place of the default text are included with Font Printer 2.0.    The files 
are located in your Font Printer directory and have a    .TXT extension.

To tell Font Printer to use Custom text when printing font samples:

1. Depress the  button on the toolbar

2. Type in the text that you would like to use when printing font samples.
3. If you wish to save the text you just typed, choose File/Save on the menu.    When prompted, 
enter the name of the file that you want to save the text in and press the OK button.
4. Press the OK button to return.

To load Custom text from an ASCII file:

1. Depress the  button on the toolbar.

2. Choose File/Open, choose a file and press the OK button.
3. Press the OK button to return.

See also:
Printing Default text



The Text menu

The Text menu lets you tell Font Printer to print either the Default text or the Custom text and change the 
Sample text.    The Sample text is the text that appears just below the list boxes where you make your font 
selections.

See also:
Print with Default text
Print with Custom text



The Help menu

The Help menu allows you to view this help file or display information about Font Printer. 



Screen fonts vs. Printer fonts

An important concept to understand while using Font Printer is that there are two types of fonts available 
under Windows, screen fonts and printer fonts.    You cannot display a printer font if there is no associated 
screen font.    Some printers have built in fonts that do not have corresponding screen fonts    These fonts 
cannot be displayed, they can only be printed.




